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Lr/KSRMCE/CE/2019-20/ Date: 04-09-2019

To

The Principal,
KSRMCE,
Kadapa.

Sub: Permission to Conduct Value Added Course on “REVIT Architecture” from 9/9/2019 to
27/9/2019-Req- Reg.

Respected Sir,

The Department of Civil Engineering is planning to offer a Value Added Course on “REVIT
Architecture” to B. Tech. students. The course will be conducted from 9/9/2019 to 27/9/2019.
In this regard, I kindly request you to grant permission to conduct the value added course.

Thanking you,
Yours faithfully
Q\N)
K. Ravali
(Asst. Professor, CED)
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K.S.R.M. COLLEGE OF ENGINEERING
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Approved by AICTE, New Delhi & Affiliated to JINTUA, Ananthapuramu.
An ISO 14001:2004 & 9001: 2015 Certified Institution

Cr./KSRMCE/CE/2019-20/ Date: 04/09/2019

Circular

The Department of Civil Engineering is offering a Value Added Course on “REVIT
Architecture” from 9/9/2019 to 27/9/2019 to B.Tech students. In this regard, interested
students are requested to register their names for the Value Added Course with following
registration link.

https://docs.google.com/forms/u/1/d/e/1F AlpQLScdZUF2BCr9mvWJIdCU5SjZd2UFqFiOO
mQzKYQsEdYGV8bA WTw/viewform

For further information, contact Course Coordinator.

Course Coordinator:

K. Ravali,

Assistant Professor,

Department of Civil Engineering,

KSRMCE.
HOD
Dept. of Civil Engineering
Cec to:

IQAC-KSRMCE
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DEPARTMENT OF CIVIL ENGINEERING
List of students registered for Value Added Course on
“REVIT Architecture” from 9/9/2019 to 27/9/2019

I\SI:;. Roll Number Name of the student Semester | Branch
1 179Y1A0131 Sreekanthgurakanivari \Y% Civil
2 179Y1A0133 Dharanijonnavaram V Civil
3 179Y1A0136 | Himajakancharla \% Civil
4 179Y1A0138 Vamsi Karthikkoppoli V Civil
5 179Y1A0139 | Vivekananda Reddykota \% Civil
6 179Y1A0142 | Bharath Kumarkothamass V Civil
7 179Y1A0143 | Purnendra Krishnakumbagiri \% Civil
8 179Y1A0144 | Rajesh Reddykuncha Vv Civil
9 179Y1A0146 | Madhu Kiran Reddybannuru Vv Civil
10 179Y1A0IAO0 | Maheswar Reddytunga \ Civil
11 179Y1AO01A6 | Rekha Deviyarasani \% Civil
12 179Y1AO01A9 | Yogeshwar Reddyyarramachu \Y Civil
13 179Y1A01B0 | Surendrayatagiri v Civil
14 189Y5A0102 | Siva Gangadharalavalapadu v Civil
15 |1 1agwsAolee | Dnatani Kemaldiar v Civil

Raoappalarajugari
16 189YSA0110 | Purushothamreddybijivemula V Civil
17 189Y5A0111 Swarupa Ranibiranna \% Civil
18 189Y5A0112 | Jagadeeswar Reddyboggula \% Civil
19 189Y5A0120 | Swethadamsetty Vv Civil

20 189Y5A0123 Charan Kumargandi \4 Civil
21 189Y5A0126 | Shireeshaguramkonda Vv Civil
22 189Y5A0127 | Nikithajaladi \% Civil
23 189Y5A0132 | Yaswanth Reddykambham \% Civil
24 189Y5A0136 | Sudharshan Reddykora \" Civil
25 189Y5A0137 | Lokeshkothapalli \Y% Civil
26 189Y5A0140 | Sureshkuruva \4 Civil
27 189Y5A0141 Pavankumar Reddylekkala \ Civil
28 189Y5A0142 | Rajasekharmekala Vv Civil
29 189Y5A0143 Venkatakishoremonaboti \% Civil
30 189Y5A0145 | Sanjaynalli Vv Civil
8] 44 1agisanige | 1ol dRAmeana v Civil

Reddynimmakayala

32 189YSA0153 Lakshmi Narendrapeddamodium vV Civil
33 189Y5A0159 | Abilash Reddysajjala \% Civil
34 189Y5A0163 Ibrahimshaik v Civil




35 189Y5A0166 | Nayab Rasoolshaikbaragajji Vv Civil
36 189Y5A0167 | Vijay Kumarsirigiri \% Civil
37 189Y5A0171 Divyathonduru Vv Civil
38 189Y5A0172 Parameswara Reddythummala N Civil
39 189Y5A0179 | Narendra Kumar Reddyyanamala \4 Civil
40 189Y5A0180 | Venkata Kiranyarragundu \Y% Civil
Coordinator HOD :
Head
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Registration for Value Added Course on
"REVIT ARCHITECTURE " From
9/9/2019 to 27/9/2019

ravalice@ksrmee.ac.in (not shared) Switch account
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* Required
Roll Number *

Your answer

Name of the Student *

Your answer

B.Tech Semester *

O 1 sem
(O 1 sEM
(O MU SEM
O VSEM
O V SEM
O VISEM
O VIISEM
O VIISEM




Branch *

CIVIL
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EEEE

CSE

O 0 Q00O

Email ID *

Your answer

Clear form

Never submit passwords through Google Forms.

This form was created inside of KSRM College of Engineering. Report Abuse

Google Forms




Syllabus of Value Added Course

Course Name: REVIT Architecture

Course Objectives:

Understand the principles of Building Information Modeling (BIM) and become proficient
in navigating and utilizing the Revit Architecture interface.

Learn to create and manipulate architectural components such as walls, doors, and
windows, while also exploring techniques for editing and modifying these elements.

Gain skills in generating 3D views, creating section views, and using rendering techniques
to produce visualizations and walkthroughs of architectural designs.

Develop the ability to organize views, create schedules, and arrange documentation
elements for effective project presentation and submission.

Course Outcomes: Upon completing the course students will be able to:

Effectively navigate the Revit Architecture interface, demonstrating a solid understanding
of key tools and functionalities for building information modeling.

Capable of creating, placing, and editing essential architectural components, such as walls,
doors, and windows, showcasing proficiency in accurately representing building structures.
Generate diverse visualizations, including 3D views, section views, and rendering
techniques, enabling them to communicate design concepts more effectively.

Organize views, develop schedules, and arrange documentation elements systematically,

resulting in coherent and professional project presentations suitable for submission and
review. '

Contents:

Introduction to Building Information Modeling
Revit Architecture Introduction
User Inter Face
Setting of Units & Working with Elevation Views
Placing Walls, Doors & windows
Editing of Walls, Doors & Windows
Properties Palette
o Type Selector

i s =y -l SEEY

o Type Parameters

o Instance Parameters
8. Managing Views by Project Browser
. Placing of Family Files(Components)
10. Modify Tools
11. Roof & Types of Roofs
12. Floor & Types of Floors
13. Ceiling
14. Explain about Curtain wall
15. Creating Section Views
16. Different Types of Openings
17. Staircase




18. Ramp
19. Railing
20. Annotations
21. Model Text
22. 3-D Views

o Camera Views
o Rendering

o Walkthroughs
23. Paint
24. Creating New Materials
25. Massing & Site
26. Schedules
27. Page Layout
28. Documentation
29. Project Submission

Textbooks:
1. Atefe Makhmalbaf (2022), Building Information Modeling using Revit for Architects and

Engineers, Mavs Open Press.
2. Revit Essentials for Architecture by Paul F. Aubin, https:/paulaubin.com/books/

revitessentials -for-architecture/.

Head
¢ of i 1 t e 'ng
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K.S.R.M. COLLEGE OF ENGINEERING

(UGC-AUTONOMOUS)
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SCHEDULE

Department of Civil Engineering
Value Added Course on
“REVIT Architecture” from 9/9/2019 to 27/9/2019

Date Timing Resource Person Topic to be covered
Introduction to Building Information
09/09/2019 | 4PMto6PM | U. Arun Kumar Modeling, Revit Architecture
Introduction
User Inter Face, Setting of Units &
10/09/2019 | 4PMto6 PM | U. Arun Kumar Wiiking with Elevation Views
User Inter Face, Setting of Units &
11/09/2019 | 4PMto6PM | U. Arun Kumar WoltzmwithElevation Views
12/09/2019 | 4PMto6PM | U. Arun Kumar ot ¥l Doswsic mindaws;
Editing of Walls
13/09/2019 | 4PMt06PM | U. Arun Kumar L seme W ool uinunwns;
Editing of Walls
Doors & Windows Properties Palette,
14/09/2019 | 2PMto6PM | U. Arun Kumar Managing Views by Project Browser,
Placing of Family Files
Modify Tools, Roof & Types of
16/09/2019 | 4PMto6PM | U. Arun Kumar Roofs, Floor & Types of Floors
Modify Tools, Roof & Types of
17/09/2019 | 4PMto6PM | U. Arun Kumar Roeifs, Floor:& Types of Floors
18/09/2019 | 4PMto6 PM | U. Arun Kumar Ceiling, Explain about Curtain wall
19/09/2019 | 4PMto6PM | U. Arun Kumar Ceiling, Explain about Curtain wall
20/09/2019 | 4PMto6 PM | U. Arun Kumar Creating Section Views
21/09/2019 | 2PMto6PM | U. Arun Kumar Different Types of Openings,
Staircase, Ramp, Railing,
23/09/2019 | 4PMto 6 PM | U. Arun Kumar Annotations, Model Text, 3-D Views
Paint, Creating New Materials,
24/09/2019 | 4PMto6 PM | U. Arun Kumar Maissing. & Site, Schadilles
Paint, Creating New Materials,
25/09/2019 | 4PMto6PM | U. Arun Kumar Messing.& Site. Schediles
26/09/2019 | 4PMto6PM | U. Arun Kumar Page Layout, Documentation, Project
Submission
27/09/2019 | 4PMto6PM | U. Arun Kumar ~ape L ayaut, Dognmentation, Bidject

Submission

Resource Person(s)

o’

Coordinator(s)
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K.S.R.M. COLLEGE OF ENGINEERING

(UGC-AUTONOMOUS)
Kadapa, Andhra Pradesh, India— 516 003
Approved by AICTE, New Delhi & Affiliated to JNTUA, Ananthapuramu.
An ISO 14001:2004 & 9001: 2015 Certified Institution

Report of
Value Added Course on “REVIT Architecture”
From 09/09/2019 to 27/09/2019

Target Group E B. Tech. Students
Details of Participants : 40 Students
Co-coordinator(s) : Smt. K. Ravali
Resource Person(s) : U. Arun Kumar
Organizing Department : Civil Engineering

. Venue 2 CADD Lab, Civil Department
Description:

The Department of Civil Engineering conducted a Value Added Course on “REVIT Architecture” from 9™
September 2019 to 27" September 2019. The course was instructed by Sri. U. Arun Kumar, Assistant
Professor, Civil Engineering and coordinated by Smt. K. Ravali, Assistant Professor, Department Civil
Engineering, KSRMCE.

Revit Architecture's 3D modeling capabilities play a pivotal role in modern architectural and construction
practices, offering a wide array of benefits that significantly enhance the design, visualization, collaboration,
and efficiency of projects. Here's a review of the importance of Revit Architecture's 3D modeling: Revit
Architecture's 3D modeling empowers architects, designers, and stakeholders to visualize their designs in
three dimensions. This realistic representation provides a clear and immersive understanding of how a
. project will look and feel once completed. This aids in making informed design decisions, identifying
potential issues early in the design process, and ensuring the final product aligns with the envisioned
concept. Revit Architecture's 3D modeling is a fundamental component of Building Information Modeling
(BIM), which is a collaborative approach to design and construction. BIM leverages the 3D model as a
central repository of information that can be accessed and updated by all project stakeholders. This
integration fosters seamless collaboration and reduces the risk of information loss. The 3D models created in
Revit Architecture are not just visual representations; they also contain a wealth of data. This data can be
used for accurate quantity takeoffs, cost estimation, and material scheduling. This quantitative analysis
streamlines the project's budgeting and planning processes. ssThe course mainly aims to enhance the 3D

modeling capabilities using Revit Architecture.




Photos:

The pictures taken during the course are given below:

What is Revit Architecture?

Revit architecture is a robust architecture designs and
documentation  software application created by
autodesk  for architecture  design and building
professionals.

The tools and features up revit architecture are in
particular. Revit architecture design o support 10
building information modeling (BIM) works. Revit
architecture is able 10 support information in
application, models to allowing complex building

structures to be accurately.
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DEPARTMENT OF CIVIL ENGINEERING

Attendance sheet of Value Added Course on “REVIT Architecture”
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Parameswara
18 189Y5A0172 Reddythummala

Narendra Kumar

39 189Y5A0179 Reddyyanamala
Venkata
40 189Y5A0180 Kiranyarragundu
Coordinator(s) Q{)D
Head

Department of Civil E:‘:g‘ir:eer%ng
K.S.R.M. Coliege of Engineering
i (Autonomox.is)
KADAPA - 516 003. (A.P)



Feedback form on Value Added Course
"REVIT ARCHITECTURE" from
9/9/2019 to 27/9/2019

@ ravalice@ksrmee.ac.in _(not shared) Switch account

)

* Required

Roll Number *

Your answer

Name of the Student *

Your answer

The objectives of the Value Added Course were met*

O Excellent
O Good

O Satisfactory

O Poor




The content of the course was organized and easy to follow™

O Excellent
O Good

O Satisfactory

O Poor

The Resource Person was well prepared and able to answer any question

O Excellent
O Good

O Satisfactory

O Poor

The exercises/role play were helpful and relevant *

O Excellent
O Good

O Satisfactory

O Poor




The Value Added Course satisfy my expectation as a value added Programme

O Excellent

O Satisfactory

O Good
O Poor

Any other comments

Your answer

Clear form

Never submit passwords through Google Forms.

This form was created inside of KSRM College of Engineering. Report Abuse

Google Forms



K.S.R.M. COLLEGE OF ENGINEERING

(UGC-AUTONOMOUS)
Kadapa, Andhra Pradesh, India— 516 003
Approved by AICTE, New Delhi & Affiliated to INTUA, Ananthapuramu.
An ISO 14001:2004 & 9001: 2015 Certified Institution

DEPARTMENT OF CIVIL ENGINEERING

Feedback of Value Added Course on “REVIT Architecture”

LR The content of | The Resource Person | The The Value Added
The objectives § -
Sl the course was | was well prepared exercises/role | Course satisfy my
of the Value : :
N | Roll No. Name organized and | and able to answer play were expectation as a
Added Course :
o. easy to follow | any question helpful and value added
were met
relevant Programme
| 179Y1A0131 | Sreekanthgurakanivari Excellent Excellent Excellent Excellent Excellent
’ 179Y1A0133 | Dharanijonnavaram Good Satisfactory Excellent Excellent Excellent
3 179Y1A0136 | Himajakancharla Excellent Excellent Excellent Good Excellent
4 179Y1A0138 | Vamsi Karthikkoppoli Excellent Good Excellent Excellent Good
5 179Y1A0139 | Vivekananda Reddykota Excellent Excellent Excellent Good Excellent
6 179Y1A0142 | Bharath Kumarkothamass Excellent Good Excellent Excellent Good
7 179Y1A0143 | Purnendra Krishnakumbagiri Good Excellent Excellent Good Excellent
g 179Y1A0144 | Rajesh Reddykuncha Excellent Good Excellent Good Excellent




9 179Y1A0146 | Madhu Kiran Reddybannuru Good Excellent Excellent Good Excellent
10 179Y1A01A0 | Maheswar Reddytunga Excellent Satisfactory Good Good Excellent
T 179Y1A01A6 | Rekha Deviyarasani Excellent Excellent Excellent Excellent Good
12 179Y1A01A9 | Yogeshwar Reddyyarramachu Excellent Good Excellent Excellent Excellent
13 179Y1A01B0 | Surendrayatagiri Good Excellent Excellent Excellent Excellent
14 189Y5A0102 | Siva Gangadharalavalapadu Excellent Good Good Good Excellent
s 189Y5A0104 Ezggi;iaﬁigigi?m Excellent Excellent Excellent Excellent Satisfactory
16 189Y5A0110 | Purushothamreddybijivemula Excellent Good Excellent Excellent Excellent
17 189Y5A0111 | Swarupa Ranibiranna Satisfactory Excellent Good Excellent Excellent
8 189Y5A0112 | Jagadeeswar Reddyboggula Excellent Good Excellent Satisfactory Excellent
19 189Y5A0120 | Swethadamsetty Excellent Excellent Good Excellent Excellent
20 189Y5A0123 | Charan Kumargandi Excellent Good Excellent Excellent Good
91 189Y5A0126 | Shireeshaguramkonda Excellent Good Excellent Excellent Excellent
2 189Y5A0127 | Nikithajaladi Good Good Excellent Good Excellent
23 189Y5A0132 | Yaswanth Reddykambham Excellent Excellent Excellent Excellent Good




24 189Y5A0136 | Sudharshan Reddykora Excellent Excellent Excellent Good Excellent
55 189Y5A0137 | Lokeshkothapalli Good Good Excellent Excellent Good
26 189Y5A0140 | Sureshkuruva Excellent Excellent Good Good Excellent
7 189Y5A0141 | Pavankumar Reddylekkala Good Good Excellent Good Excellent
23 189Y5A0142 | Rajasekharmekala Excellent Excellent Good Good Excellent
29 189Y5A0143 | Venkatakishoremonaboti Excellent Excellent Excellent Good Excellent
30 189Y5A0145 | Sanjaynalli Good Excellent Good Excellent Good
189Y5A0146 Venkata- Rema Excellent Good Good Excellent Excellent
31 Reddynimmakayala
1 189Y5A0153 | Lakshmi Narendrapeddamodium Good Excellent Good Good Excellent
13 189Y5A0159 | Abilash Reddysajjala Excellent Excellent Excellent Excellent Good
34 189Y5A0163 | Ibrahimshaik Good Good Excellent Good Excellent
35 189Y5A0166 | Nayab Rasoolshaikbaragajji Good Excellent Good Excellent Good
16 189Y5A0167 | Vijay Kumarsirigiri Good Good Excellent Good Excellent
37 189Y5A0171 | Divyathonduru Good Excellent Good Good Excellent
38 189Y5A0172 | Parameswara Reddythummala Excellent Good Excellent Good Excellent




KADAPA - 516 003. (AP)

e piA. Eggﬁ‘;‘;?nz;zzr Excellent Good Excellent Excellent Excellent
40 189Y5A0180 | Venkata Kiranyarragundu Excellent Good Excellent Excellent Excellent
Coordinator s
Head
Department of Civil Eng!neeri_ng
K.S,R.M, College of Engineenna
g (Autonomous)




K.S.R.M College of Engineering

(AUTONOMOUS)
KADAPA, ANDHRA PRADESH, INDIA-516003

DEPARTMENT OF CIVIL ENGINEERING

CERTIFICATE OF COURSE COMPLETION
This certificate is presented to

D. Rekha (Reg. No. 179Y1A01A6), Student of KSRM College of Engineering (Autonomous)
for successful completion of value added course on “REVIT Architecture” offered by Depart-
ment of Civil Engineering, KSRMCE-Kadapa.

- Course Instructor:
Course Duration: 38 Hours; j :
From: 09/09/2019 to 27/09/2019 Sri U. Arun Kumar, Assistant Professor, |

Department of Civil Engg., KSRMCE-Kadapa

Qo\lp/{ (\j/wf") V. 8. € Pl

Coordinator Head of the Department Principal




K.S.R.M College of Engineering

(AUTONOMOUS)
KADAPA, ANDHRA PRADESH, INDIA-516003

DEPARTMENT OF CIVIL ENGINEERING

CERTIFICATE OF COURSE COMPLETION
This certificate is presented to
Charan Kumargandi (Reg. No. 189Y5A0123), Student of KSRM College of Engineering

(Autonomous) for successful completion of value added course on “REVIT Architecture” of-
fered by Department of Civil Engineering, KSRMCE-Kadapa.

- Course Instructor:
Course Duration: 38 Hours; . ;
From: 09/09/2019 to 27/09/2019 Sri U. Arun Kumar, Assistant Professor,
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= In the “Open” dialog box, browse to the Chapter02 folder.
= Double-click Chapter02.rvt to open the project. You can also select it and then click the Open button.

The project will open in displaying a sheet with an overhead 3D view.
The dataset for this chapter provided courtesy of Mark Schmieding, FAIA.

GETTING ACQUAINTED WITH THE PROJECT

For this turorial, we will explore a series of sheet views included in the project. A sheet view is a special kind of view
that emulates a sheet of paper from which drawing sets can be printed to output devices. Sheet views typically include
a title block which contains project and drawing information. Revit remembers the last view that was open when
the project was saved. In this case, it is a three-dimensional acrial view of this small one-floor project for a youth

center. It includes offices, exam and counseling rooms, a multipurpose room, and media rooms. Let’s take a closer
look (see Figure 2.10).
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FIGURE2.10 7he Youth Center dataset shown from the “Function Diagram” sheet

VIEW NAVIGATION

You can use the wheel on your mouse to zoom in and out in any view. You can hold the wheel in and drag to pan the
screen. If you are working on a laptop and don't have a wheel mouse, you can use the commands on the Navigation
Bar (located by default in the upper right corner of the view window) to navigate in any view. Depending on the
kind of view active on screen, you will have access to differing tools on the Navigation Bar (see Figure 2.11). Among

these are the Steering Wheel, the Zoom pop-up, and the ViewCube. The ViewCube and 3D steering wheel appear
in 3D views.
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FIGURE .11 Zoom the sheet to Sheet Size and pan around to see it as it will prine. Pan with the wheel mouse or the steering wheel

NOTE: Revit includes 3D connexion device support. If you have one of these devices connected to your
computer, you can use it to navigate in 2D and 3D views. Additional icons will appear on the Navigation
Bar indicating that the device is detected and available for use in Revit. Learn more at: 3dconnexion.com.

The zoom pop-up offers many ways to zoom the current window. Most of these commands will be available in all
kinds of views, like: Zoom To Fit (which fits the screen to the extent of the model) and: Zoom In Region (which
allows you to drag a rectangular region on screen to magnify that area). We also have the handy: Zoom Sheet Size
available. This command zooms a view to a size comparable on screen to the actual size it will appear when printed.
Since Revit displays line weights and other graphics accurately on screen, this can give you a good preview of how
the sheet will look when printed (with today’s high resolution monitors, this is a good approximation). Each of the
zoom commands has a command shortcut that you can execute via the keyboard. These shortcuts are two characters
and you simply type both characters in succession to execute the appropriate command. For example, to issue Zoom

to Fit, you can simply type: ZE All of the zoom shortcuts are shown in Table 2.D.
TABLE 2D Keyboard shortcuss for Zoom commands

Zoom Command Keyboard Shortcut
Zoom in Region ZR
Zoom Out (2x) Z0
Zoom to Fit ZF
Zoom All to Fit ZA
Zoom Sheet Size ZS
Previous Pan/Zoom yAY
1. From the Zoom pop-up on the Navigation Bar, choose: Zoom In Region.

You can also type ZR to issue this command. If Zoom in Region is already selected {a checkmark
appears next to it) then simply click the zoom icen to execute the command.

= Drag a rectangular region around the upper left corner of the drawing.
2 Hold in the wheel on the mouse and drag around to pan the model.

If you prefer, you can use the scroll bars instead.

The image you see on screen is the view named: Large Overview. It is in the 3D Views branch of the Project Browser.

It has been added to the current sheet and displays in a “Viewport™.

3. Zoom back out. The easiest way is to choose: Zoom to Fit from the Zoom pop-up menu (shortcut: ZF).
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The Steering Wheel offers an alternative to wheel mouse navigation with such commands as dynamic zoom and
pan. Click the Steering Wheel icon to make it appear. In this case, since we have a sheet active, only the two-di-
mensional commands will appear. (This is true even though a 3D view is placed on the sheer; the sheet itself is still
two-dimensional).

4. Click on the Steering Wheel icon (the too! tip will read “2D Wheel”).

Each function works the same way. Place your mouse on the area of the wheel for the function you want. It will
highlight as your cursor passes over it. You are also simultaneously moving the wheel around the screen with the
movement of your mouse, so it takes some practice. Click and drag with the mouse to begin the function. For exam-
ple. if you wish to zoom, move the wheel to the area of the screen that you wish to center your zoom on, move the
pointer over the Zoom part of the wheel, click and hold down the mouse and begin to drag. Dragging up zooms in,
dragging down zooms out. Varying the speed of your dragging varies the speed of the zooming, Release the mouse
button to stop zooming and make the wheel reappear to change functions. Pan works the same way excepr that
panning occurs in the direction that you drag (see Figure 2.12).

& i Click apg drag on the reaind to meve backward
Seady and torwsrd tirough your zocm asd pan history

Drag v Drag any
to 106m \d‘sreaiol 1o :an/'
£ o
£ 4 3

l Drag doan
to zoom out
FIGURE2.12 Steering wheels offer many view navigation finctions. Drag on the part of the wheel labeled for the function you want to use

As you perform several zooms and pans, they are stored in memory. You can use the Rewind function 1o back up
through previous zooms and pans in a visual way. Move your mouse pointer over the Rewind function, click and
hold down. A ribbon of thumbnail previews will appear, each representing a previous zoom or pan. Drag to the left
to highlight previous zooms and pans, drag back to the right to move forward. Release the mouse to stop rewinding

or forwarding. When you are done with the wheel, click the small dose box (“X”) in the upper right corner of the
wheel or press Esc.

5. When finished experimenting with Steering Wheel, close it to continue.

UNDERSTANDING SCREEN TOOL TIPS

You can get feedback on the elements onscreen as your mouse passes over them.

1. Zoom to Fit. (In addition to the methods already covered, you can right-
click to access common zoom commands like Zoom to Fit.

= Move your mouse pointer into the middle of the screen and pause
it there—pause over the drawing, (not a text note).

Do not click the mouse.

Notice how a rectangular border highlights around the 3D image. As you pause the mouse, an onscreen tool tp
should appear as well. In this case, this tip will read: Viewports : Viewport : No Title (see Figure 2.13).

NOTE: The same information ai)pears in the status line at the bottom ieft corner of the Revit interface.

¢ Revit Essendials for Architecture »
Copyright (c) 2020 Paul F. Aubin, All rights reserved




54 | Chapter 2

Properties X E 00 - Function Diagram X
Sheet vi
§§hm_Fu_ncﬁon Diagram - Edit Type |
Graphics | -
Visibility/Graphic..|  Edit. | .

Properties help Dy
Project Browser - Chapter02.nvt
=10, Views (all) ~
LI Floor Plans
Main Floor
_Furniture Plan When you hover over an
_Room Callouts item, a tooltip will often 7
appear as will 2 me e
General Purpose Room i oﬁpf—hc i 553g
Plan Detail
Roof
Street Level
= Ceiling Plans
Ceiling Plan
=i 3D Views
Axon
Large Overview
Overview 8
L -0y R
Viewports : Viewport : No Title - & LR £ 0 [ 38 i Mode

FIGURE 2.13 Taol Tips will indicate the element category, family, and type

|| Social Services Board

Youth Center

LR

The tool tip conveys three bits of information about the element highlighted—its Category : Family name: Type
name. So, in this case, the element category is “Viewports,” the family is “Viewport” and the type is “No Title.”

2. Now hover the pointer over a piece of text but do not click.
This is called “Pre-highlighting.” The tool tip for a piece of text will read—Text Notes : Text : 3D Notes. Here, Text
Notes is the category, Text is the family and 3D Notes is the type. Since the 3D view is a viewport containing one
of our project views, you do not see the elements within the model pre-highlighting. However, you can choose to
“Activate” the viewport and that will give you access to the building model elements shown within the view. Editing

them from a viewport is no different than opening the view from the Project Browser and editing them there; the

results are the same view either way. Let’s take a look.

3. Pre-highlight the viewport, and then click to select it this time.

= On the Modify | Viewports ribbon, click the Activate View button (you can double-click inside the viewport as well).
Notice that the sheet title block and the text labels have grayed out. While they are still visible, this graying effect
indicates thar they are currently inactive and that you are now working inside the viewport.

4. Move the mouse around the model.

Notice that the elements within the model now pre-highlight.
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FIGURE 2.14 Once the viewport is activated, you can pre-highlight the elements in the model

We will not actually edit any model objects in this view but do take notice of the tool tips. The interior partitions,
for example, display as: Walls : Basic Wall : Generic - 6". The category is: Walls, the family is: Basic Wall and the
type is: Generic - 6" (see Figure 2.14).

Feel free to select objects if you like, but don't edit anything. If you accidentally move or change an element, click
the undo icon on the Quick Access Toolbar (QAT) at the top left corner of the Revit interface. Or press cTRL + z.

You may also notice that with the three-dimensional view now active, in addition to the Navigation Bar, the ViewCube
is also displayed. The ViewCube is a 3D navigational tool available in all Aurodesk products. Clicking on any of the
labeled sides of the cube will orient the view to that direction such as top, front, or right. There are also several active
regions between faces that will orient the view at an angle between the two adjacent faces. For example, click the
edge between front and right to orient the view to the southeast. Click the corner between three faces to orient the
view to an axonometric orientation. You can also click and drag any edge of the cube to orbirt the model in real-time.
Feel free to experiment with the ViewCube to get the hang of it (see Figure 2.15).

FIGURE 2.15 Three-dimensional views show the ViewCube. Use it to quickly reorient the 3D view

In addition to the ViewCube, the Steering Wheel has more options in a three-dimensional view. You can orbir the
view, change the center of rotation, move the vantage point up and down, and walk and look around the model.
Consult the online help for more information on these options and the many ways you can customize the Steering
Wheels to suit your preferences.

5. Feel free to experiment with the ViewCube and the 3D Steering Wheel in this 3D view.

= Before continuing, reset the view back to its original state.
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To do this, click the Steering Wheel, and then use the Rewind tool or right-click on
the Steering Wheel and choose: Undo View Orientation Changes.

6. When you are done exploring in the model, right-click in the Viewport again and choose: Deactivate View.

This returns you to the sheet and the elements in the view are no longer selectable.

VIEWS AND DETAILING

Earlier we discussed how model and annotation elements were handled in distinct ways. Continuing in this file, let’s

explore the difference between model and view-specific/annotation elements a bit further.

1. On the Project Browser, beneath the Views (all) branch, double-click to open the: _Main Floor plan view.

This is the basic floor plan view for this project.

2. On the Project Browser, double-click to open the _Room Callouts plan view.
This plan is very similar to the _Main Floor view except that it also includes callouts around the General Purpose
Room on the left and some elevation and section markers. A sheet has been provided showing each of these views.

3. On the Project Browser, beneath the Sheets (all) branch, double-click to open the 05 — Room Callout sheet view.

Notice how the only visual difference here is that the plan appears on a title block sheet in this view.

4, On the Project Browser, double-click to open the 02 — Floor Plan sheet view.
This is the sheet presentation of the _Main Floor plan view. In other words, this sheet composes the _Main Floor plan
view on a title block for printing. You can easily see which views appear on a sheet in the Project Browser.

B On the Project Browser, beneath the Sheets branch, expand the tree (click
the small plus (+) sign) beneath the 01 — Shaded Plan sheet.

= Double-click the sheet to open it (see Figure 2.16).
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FIGURE 2.16 Expand the sheet entries in the Praject Browser to see the views they contain
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This provides an easy way to see which views are inserted on sheets. Another useful tool (noted above) gives us a way
to see which views have not yet been placed on sheets.
6. On the Project Browser, scroll to the top and select the Wiews (ail) branch.

= On the Properties palette, from the Type Selector {drop down list at the
top), choose: not on sheets (similar to Figure 2.9 above).

Notice that the list of views on the Project Browser now shows only those views that are not yet assigned to a sheer.
In this project, there are only a couple views not placed on sheets. Expand each sub-group to see.

7 & Make sure that “Views (not on sheets)"” is selected, and then on the Properties palette, change back to: all.

This sets the default browser organization back to showing all views regardless of their placement on sheets.

8. On the Project Browser, double-click to return to the _Main Floor plan view. Or just click its tab if it is still open.

Suppose that we needed to create another floor plan that was similar to this one, but that was to convey a different
type of information on the printed sheet or that we were planning to use simply as a convenient place in which to

edit the model with no intention of adding it to a sheet. To achieve either goal, we simply duplicate an existing view.

9. On the Project Browser, right-click the _Main Floor plan view and choose: Duplicate View > Duplicate.

A new foor plan view named: _Main Floor Copy 1 will appear and become active. Notice that none of the room
labels or dimensions were copied in this operation. This might be useful if you were creating a “working” view. A
“working” view is intended as a view in which you manipulate the model only and do not plan to add to a sheet for
printing. Bear in mind that nothing prevents the working view from being used on a sheet; rather it is simply not

intended for that purpose by our project team. If we want to duplicate the view, including the tags and dimensions,
we choose a different command.

10.  Onthe Project Browser, right-click the original _Main Floor plan view again
and choose: Duplicate View > Duplicate with Detailing.

NOTE: “Duplicate with Deta:]mg" is §h"o:f't for “Duplicate with view-specific detailing elements and
annotation elements.” Remember that the “detailing” is being copied, while the model elements are simply
being viewed. : .

A new floor plan view named: _Main Floor Copy 2 will appear and become active. Notice that this copy includes
copies of the room tags and dimensions.

= Right-click _Main Floor Copy 2 and choose: Rename.
= Type: Area Dlagram and then press enver.
11.  With the ctrL key held down, select each of the dimensions in the view (five total).

= Press the pecLeTe key.

We do not need dimensions for the new view we are creating. However, there is no way to duplicate only the room
tags and not the dimensions, so simply deleting them achieves the desired result. But the critical thing to remember
here is that the dimensions still exist in the original _Main Floor view. We only deleted the copied ones here.

12.  Onthe Annotate tab of the ribbon, on the Color Fill panel, click the Caolor Fill Legend tool.
A small square with a tag will appear attached to the cursor.

= Click a point above the plan to place the Color Scheme Legend.
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= In the dialog that appears, for Space Type, choose: Rooms and then click OK.

As you can see, the Scheme 1 color scheme color codes each room based on its name. The legend itself is currently

overlapping the plan. To make it fit better, we can resize and/or move it.

13.  Click on the Color Fill Legend and then drag the small round Control at the
bottom up to make the legend two columns (see Figure 2.17).
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FIGURE 2.17 Create a Legend for the new shaded plan and then resize the legend

14.  Onthe Project Browser, double-click to open the 04 — Area Diagram sheet view.

A sheet appears on screen, which does not yet have a drawing on it. Let’s add our new shaded plan to this sheet.

= On the Project Browser, right-click the 04 — Area Diagram sheet and choose: Add View.

= From the “Views” dialog, choose: Floor Plan: Area Diagram view and then click the Add View to Sheet button.

= Click to place the view on the sheet.
Notice that the view is a little too big for the sheet. We can adjust the scale of the view and it will update automat-
ically on the sheet.

15.  On the Project Browser, select the: Area Diagram view.

= On the Properties palette, from the View Scale list, choose: 1/8"=1'-0" (see Figure 2.18).
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FIGURE2.18 Change the scale of the view

You should see the change on the sheet immediately. If necessary, you can move
the viewport around to make a nicer composition on the sheet.

You should also look at the _Furniture Plan floor plan view and the 03— Layout Plan sheet next. In this view and
sheet, you will notice that the plan is displayed with furniture. Therefore, creating plans with and without detailing
(text and other annotartion) is not the only way to vary the specifics of what we see. We can also control the visibility
of each type of element in any Revit view. The visibility settings are a parameter of the view itself. This is how we
can choose to display the furniture in the _Furniture Plan view and not display it in the _Main Floor view. On the
View tab of the ribbon, on the Graphics panel, you can choose the Visibility/ Graphics tool (VG). This will display
a dialog listing all element categories and enables you to turn on and off these categories within the current view.
While we will discuss the specifics of this process in later chapters, the important point for this exercise is that this
sort of control is possible and extremely useful. If you wish to explore the “Visibility/Graphics Overrides” dialog,
please feel free to do so. Simply undo your changes before continuing with the lesson.

EDIT IN ANY VIEW

Perhaps the most powerful feature of Revit is the ability to edit in any view and see the results instantly in all views.

1. On the Project Browser, double-click to open the 06 — General Purpose Room sheet
view. Then on the View tab, on the Windows panel, click the Close Inactive button.

This closes all the other tabs. As you can see from this simple exercise, it is easy to end up with many open view tabs.
Using this tool every so often helps keep a tidy workspace and preserves computer resources. The 06 sheet we have

open shows a plan and four interior elevations. All these views show the General Purpose Room.
2. Select the plan view on the left, right-click and choose: Activate View (or double-click on the viewport).
3. On the Architecture tab of the ribbon click the Window tool.

= Click a point on the exterior wall on the left to add a new window (see Figure 2.19).
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FIGURE 2.19 Add a window and it appears in all appropriate views automatically

Notice that the window appears immediately in the north elevation (detail 5 on the sheer).

4, Right-click in the plan view again and choose: Deactivate View.

EXPLORE A DETAIL VIEW

As we have noted above, a detail view is a litcle different than the other views. Typically it will include a live view of
the model—usually a callout of some part of a section or plan—and various types of annotation and other graphical
embellishments drawn on top. One such detail view has been included in this sample dataset.

1. On the Project Browser, expand (click the plus [+] sign) the 07 — Building Details sheet view.
Beneath this sheet is a listing of three views that are already placed on the sheet.
= Beneath the 07 — Building Details sheet view entry, double-click to open the: Section : Section Detail view.

Pre-highlight some of the elements in this view (see Figure 2.20).
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FIGURE 2.20 Explore a detail view—~Note the combination of detail and model elements
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Notice that the detail view contains both model elements (which would appear in all views) and detail elements
(which appear only in this view). Even though the detail elements represent items like concrete blocks, brick, flashing,
and bond beams, the level of detail required in a construction derail is much higher than that required in nearly any
other view. Therefore, these types of items are typically drawn as detail elements on top of the model view geometry
to keep overhead low and reduce the amount of time and effort required to build your overall model. An even easier

way to see this is to change the way the model displays on the Properties palette.
3. Make sure that nothing is selected (press esc). On the Properties palette, next to Display Model, choose: Halftone.
Notice how the elements that are parts of the 3D model now display grayed out.

= Set it to: Do not display next.
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This time the model disappears and only the detailing remains.
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FIGURE2.21 Change the display properties of detailing to see the difference between model and detailing more clearly

Complete coverage of the derailing procedure can be found in Chapter 12. Continue to explore in this dataset as
much as you wish to ger a better feel of how the various elements and views in a Revit project interact. Close Revit
when you are finished exploring. You do not need to save the file.
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1 Zoom in on the middle of the right vertical exterior wall. This is where our fireplace will go.
2. On the Architecture tab, click the drop down button on the Component tool and choose: Model In-Place.

= In the “Family Category and Parameters” dialog, choose: Generic Models, and then click OK (see Figure 4.59).
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FIGURE4.59 Create an in- plaa family and choose its category

NOTE: Modeling in-place is not available in Revit LT Ifyou are using LT, you can create an actual component
family and load it instead. From the File menu, choose: New > Family. Then choose the Generic Model 1ft
[Metric Generic Model.1fi] template from the list and then dick Open. Add the reference planes as noted below,
but mstead of measuring them From the exnstmg walls, place them so that the rectanga.da,r space they describe
steps mdlcated Save the file wher.\”ﬁﬁ.xshed as: Fireplace and thea loxd it into the project and place it where

indicated in the figures below A vers:on of this family is provided in the Chapter04\Complete folder called:
Fireplace for LT rfa. L

The family category list is a fixed list built into the software. When you create a family, you must assign it one of these
categories. The family you create will inherit the characteristics of the category to which it is assigned. In general,
when choosing a category, try to select the one that most closely matches the actual object that you are creating, The
Construction Specifications Institute (CSI) spec section for fireplaces is Division 10—Specialties (10300 Fireplaces
and Stoves), which would tempt us to choose “Specialty Equipment.” However, your choice of category does impart
certain behaviors to your family. Specialty Equipment is intended more for free-standing equipment items and does
not have a “cut” representation. Items like 10340 Manufactured Exterior Specialties, 10500 Lockers or 10670 Storage
Shelving are all examples of things that would work well in the Specialty Equipment category. Items in Revit that
are “cuttable” interact with the cut plane of floor plan and section views and show bold when cut and lighter when
viewed in projection. Since we will want our fireplace to interact with the wall and appear bolder when cut in plan,
we need a category that supports cutting.

We get this curtting behavior because we chose the “Generic Models” category above. This is sort of a “catch all”

category. You typically choose Generic Models when the item you are modeling does not fit neatly into any of the
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other categories. Generic Models does not impart any specialized parameters that might be available from other more
descriptive categories, but aside from the need for interaction with the cut plane, our existing fireplace has no other

specialized needs. So Generic Model will work OK here.
= In the “Name” dialog, type: Existing Fireplace and then click OK.
You are now in “In-Place family editing” mode. The model will gray out but remain visible for reference. The ribbon

tabs will change showing a collection of In-Place family editing tools instead of the usual tools. Take a look at the
Create tab for example(see Figure 4.60).
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Select ¥ Propertizs Fosms Model Corrol ¢ Daum Wokcpime [incFiace Edtor

FIGURE4.60 The Family Editor mode is enabled when you create a new in-place family

The Create tab includes many family editing tools. You can create solid and void forms, insert Components, or add
connectors. Simply click on the other tabs to access these tools as normal. Note that several wols like walls, doors,
and floors are not available in family editing mode. You cannot place (nest) a system family within another family.
Also notice that the “In-Place Editor” panel with its Finish and Cancel buttons appears on the right side of the
ribbon in all rabs.

ADDING REFERENCE PLANES

When you construct complex geometry, it is often useful to have guidelines to assist in locating elements. Reference
planes are used for this purpose in families. You sketch a reference plane like the way you sketch walls or lines. You
can snap and constrain other elements to reference planes, making them useful tools for design layout. You can add
reference planes in any orthographic view of the model. (Reference planes do not show in 3D.) In this example, we
will add them within our In-Place family. When you add them in this way, the reference planes will become part of

the In-Place family and will be visible only when ediring the In-Place family.

1. On the Create tab, on the Datum panel, click the Reference Plane tool. (Do
not click Reference Line; make sure you click Reference Plane).

Click a point inside the large room on the right near the exterior wall, just above the lower window.
> Move the pointer horizontally to the right past the exterior wall and then click outside.

The exact locations of either click are not critical so long as you draw horizontally and above the window.
A small reference plane (green dashed line with round blue handles at the ends) will appear.

> Edit the Temporary Dimension from the bottom horizontal wall to: 7'-11" [2400] (see the left side of Figure 4.61).

» The Aubin Acadcm)' .
Copyright (c) 2020 Paul F. Aubin, All rights reserved



Creating a Building Layout | 139

: o i |
—t——— then : 1
i xb here Offset i
¥ i i e r i i § & -
i oo fgi‘ || 78 ot 4 -1 ! B ™
i i i A ot § i
| | 11 | -l ] =
| r{.1m:>)1c;ltzli’m¢n-i; ! | | s I SR 3
{  tne | Pane.| L *| Offset
4 Datun i | I | Draw ¢ D i B, =
T R TR e i copjhere | Dew NE
= | &, Mg
1 | N iz
= ; |
O - i €] = e - - s B e 7
| o < v.:}umis»;cnm: nargs" b First 1 T
| horizontal / 3 srap
| referesce plane - . i1 L pageoy ¢ o here ST 5 e
i > fset: |5 2 i =
T kit Nemm— i g
L w % 4
oo 3 i | L oo
i k Offset:| 1900 | E
] kil PR S | !
§ | } |
P . ) a ook
.___:::}‘——‘.) e .'*.'.*zm...n.._. b} T | . g - i .*-“-\4

FIGURE4.61 Create rwe horizontal and two vertical reference planes to frame out the fireplace footprine (dimensions for reference only)

3. On the Modify | Place Reference Plane tab, on the Draw panel click the Pick Lines Icon.

= On the Options Bar, in the Offset fieid, type: 6'-2" [1900].

=2 Pre-highlight the first reference plane and move the mouse so that the offset line appears above.

4, Click to create the new reference plane (second panel from the left in Figure 4.61).
Now we'll repeat the process to create two more vertical reference planes. These will frame out the rectangular foot-
print of the fireplace.

5. On the Draw panel, switch back to the Line icon, and then type: 4" [100] in the Offset field.

= Snap to the endpoint of the lower window on the inside edge of the wall.

= Snap to the endpoint of the upper window on the inside edge of the wall (third from the left in Figure 4.61).

TIP: Thestartand end points suggested will make the first reference plane fall to the inside of the house and
the second to the outside. If you click the points in the wrong order, do not cancel, simply tap the spacesar to

flip the line.

6. Switch back to the Pick Lines tool and then change the Offset to: 2'-7" [780].
= Offset the reference plane you just drew to the outside of the house (see the right side of Figure 4.61).

We now have four reference planes that we can use to guide the creation of our fire-place’s form. This is common best
practice. Complete details on the use of reference planes in families will be discussed in Chapter 11.

CREATE A SOLID FORM

Using our reference planes as a guide, let’s create the overall mass of the fireplace.
1 On the Create tab, on the Forms panel, click the Extrusion tool (see the top of Figure 4.62).

= On the Options Bar, in the “Depth” field, type: 9'-0" [2750]. (Be sure to
set the Depth and not the Offset—Item 1 in Figure 4.62.)

2. On the Draw panel, for the sketch shape, click the Rectangle icon (see item 2 in Figure 4.62).

= Snap to the intersection of two of the reference planes and then snap to an opposite
intersection to define the rectangular shape (see items 3 and 4 in Figure 4.62).

= Close all four padlocks (see item 5 in Figure 4.62).
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FIGURE4.62 Sketch the overall shape of the extrusion

2 On the Modify | Create Extrusion tab, on the Mode panel, click the Finish
button (large green checkmark) (see item 6 in Figure 4.62).

This gives us our basic fireplace mass. We now need to carve out the firebox.

CREATE A VOID FORM

Using the same basic process, we can create a Void form that will carve away from the solid form in our family giving

us the firebox opening.

1. On the Create tab, click the Void Forms drop down button and then choose: Void Extrusion.
The Modify | Create Void Extrusion tab will appear with the same Sketch tools as before.

> On the Options Bar, in the “Depth” field type: 4'-0" [1200].
On the Draw panel, click the Pick Lines icon.

= Click the left vertical edge of the solid extrusion (see panel 1 in Figure 4.63).
A magenta sketch line will appear directly on top of this edge.
On the Options Bar, change the Offset value to: 1'-0" [300].

= Highlight the right edge of the solid extrusion and move the mouse slightly until the dashed line is within
the fireplace structure. When it is, click to create a magenta sketch line (see panel 2 in Figure 4.63).

4. Change the Offset value to: 0 (zero).
= On the Draw panel, click the Line icon.

Using the temporary dimensions as a guide, click the first point on the left edge a bit down from
the top corner and draw it down and to the right at a 20° angle {(see panel 3 in Figure 4.63).

= Click the Modify tool or press the esc key twice.
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FIGURE 4.63 Skerch lines to form the fircbox shape
6. Select the 20° line and then on the Modify | Create Void Extrusion tab, click the Mirror Draw Axis tool (or press DM).

= Click the midpoint of the vertical sketch line already drawn (see panel 4 in Figure 4.63).

= Move the mouse horizontally and click the finish the mirror line (see panel 5 in Figure 4.63).
The result is shown in panel 6. Now we will use the Trim/Extend to Corner tool (the same one we used for walls at
the start of the chapter) to clean up the sketch.

7. On the Modify tab, click the Trim/Extend to Corner tool (or Type TR).

= Trim all four corners to make an enclosed shape (see Figure 4.64).

REMEMBER: Select the pordon of the skerch line that }-"c:u wish to keep.

8. Click the Modify tool or press the esc key to finish trimming.
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FIGURE 4.64 Fdir zhe sketch lines to finalize the shape
9. On the Mode panel, click the Finish Edit Mode button.

While the void is still selected, it will appear solid. However, when you deselect, it will cut away from the previously
drawn solid to form the fireplace shape.

10. Click inempty space to deselect the element,

11. Onthe In-Place Editor panel, click the Finish Model button (big green checkmark).
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This completes the editing of our family and returns us to the project editor mode.

JOIN THE FIREPLACE WITH THE WALL

The Fireplace family is finished but it overlaps the wall. Let’s fix this.
1. On the Modify tab, click the Split tool (or type SL).
= On the Options Bar, place a checkmark in the “Delete Inner Segment” check box.
2. Split the exterior vertical wall on both sides of the fireplace (see Figure 4.65).
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FIGURE 4.65 Split the exterior wall

3. Click the Modify tool or press the esc key twice.

This is close to what we want but let’s make one more edit.
4, On the Modify tab, on the Geometry panel, click the Join tool (see the top of Figure 4.65).
= Click one of the exterior walls (the ones we just split).

= Then click the Fireplace to join them (see Figure 4.66).

TIP: Remember to watch the Status Bar for detailed prompts.

5. Repeat for the other wall. Pick the wall then the fireplace.
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FIGURE 4.66 Use join Geometry to join the walls to the Fireplace
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6. Click the Modify tool or press the esc key twice to cancel the Join command.

7 On the QAT, click the Default 3D view icon.

= Use the techniques covered above and orbit the model around so that you can see the Fireplace.

We modeled the fireplace a bit too short. However, for now we will leave this alone. In later chapters we will address
the height of the fireplace as well as how it changes width on the second floor. The fireplace could also use a mantel
and a hearth. However, because there will be no new work done in the living room of this project and therefore no
sections or elevations are needed of the fireplace, that extra level of detail is unnecessary for this tutorial. What we
have created works well for the floor plan. If you wish to try it anyway for the practice, feel free. Select the fireplace,
and then on the Modify | Generic Models tab, click the Edit In-Place button. This will return you to the in-place
family editor where you can add these accoutrements using additional solids.

RESET THE CURRENT PHASE

Congratulations! Our work on residential project first floor existing conditions layout is complete for now (see Figure
4.67). We still need to add the Stairs to this model. However, Stairs will be covered in a dedicated chapter. Therefore,
we will save our layout without the Stairs for now.

|

7] [ |
) (S

FIGURE4.67 The final first floor existing conditions layons
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